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Here are all of the basic tools that you'll find in Pro One Resume.

    

    

    

    

    

    

    

    

    



Click on any of them, now, to learn more about what they do.



 The File Menu
The File Menu provides all of the features necessary to create, update, and save resumes.    
In addition, uou can use it to Exit from Pro One Resume.

Here's what you'll see when you click on the File command:

To learn more about any of the File features shown above, simply click on it, now.



 Ideas
Use this toolbar command to Print or Export a variety of idea-generating tools for your 
resume and your job search.

Here's what you'll see when you move to the Idea Screen.    Then, simply click on any of the 
items to use it.

    

    

    

    

For more information, click to see Help for Sample Resumes, Cover Letters, Thank 
You Letters, Worksheets, or Lists, now.



 The Print Menu
Use this to print your resume, change your printer's specifications or set your margins.    
Here's what you'll see when you click on this Toolbar command.

To learn more about any of these Print features (shown above), simply click on it, now.



 Spell Check
Use this toolbar command to spell check your resume.    The check will begin immediately.

If any suspicious words are found, a pop-up will appear and prompt you to make the 
necessary changes.    Options include:

Replace with the suggested word.
Ignore the correction.
Add to the Custom Dictionary.
Clear the Custom Dictionary.

Make the appropriate selection for the current word, and the check will continue.    The 
checker will notify you when it's done.

User's Tip:    Don't hesitate to add words, especially proper nouns, to your Custom 
Dictionary.    Until you have a good Custom Dictionary, spell checking can be tedious; but 
don't let that stop you -- more than one person has lost a job opportunity because of typos 
in their resume.



 View
Use this toolbar command to go to the View Screen, and get a preview of your resume.    
You'll also have access to the same toolbar features (Print, Ideas, Format, Exit, etc.) that 
appear when you're working with the Layout Screen.

For more information on the View Screen and its features, click on the highlight, 
now.



 Layout
Use this toolbar command to return to the Layout Screen.    Your current resume will remain 
in use.

Click on the highlight above to learn more about using the Layout Screen to 
design your resume.

User's Tip:    The Layout command only appears on the toolbar when you're using the View 
Screen.



 Edit
Use this toolbar command to make additions or changes to any part of your resume. As soon
as you do, a pop-up will appear and prompt you with the current information for the selected
Resume Section.    To make text corrections, simply edit the information.    Or use the copy, 
cut and paste tools to make major changes, and the insert or delete shortcut tools to update
your Experience and Education sections.

Edit can be used from both the Layout Screen and the View Screen.

User's Tips: Don't forget to select (highlight) the section that you want to edit before you 
click on Edit, or you'll receive a warning to try again.    Your updates are added to the 
resume as soon as you finish editing, but they won't be saved permanently until you click 
on the File command's Save or Save As feature.



 Format
Use this toolbar command to specify the format for your resume.    It provides a variety of 
formatting options which can be applied either to the entire resume, or to a selected 
Resume Section.

Begin by specifying the part(s) of the resume to which this format will be applied:

      

Then select the types of changes you want to make, and click on OK when you're done. Your 
formatting options include:

Font:    Name, size, bold, italic, underline and color.
Alignment:    Left justify, right justify, center or full (right and left) justify.
Hidden Text:    Use this to make certain information (such as a heading) invisible.
Indenting:    Set the number of tab stops for right or left indenting.
Bullets:    Choose from a selection of filled or unfilled bullet shapes.
Style:    Special layout options for headings and some types of body text.

Printing your resume, or previewing it on the View Screen, will show you how your format 
looks.

Click on any of the highlighted Help topics to learn more about it, now.

User's Tip:    Reviewing the Sample Resumes is an easy way to get good formatting ideas.



 Exit
Use this command to leave Pro One Resume and return to Windows.    You can find Exit 
directly on the toolbar (see icon above), or on the File Menu.

If the current resume needs to be saved before exiting, a pop-up will provide a warning and 
a chance to do so.



 The Help Menu
Use this toolbar option to learn more about how to use Pro One Resume.

Here's the complete menu of Help features (below).    Click now on any of the features, to 
learn more about how to use it:

User's Tip:    Pro One Resume's Help feature follows standard Windows conventions.    So if 
you're experienced at using the Help in other software packages, you probably won't have 
any problems using this one, either.



New
Use this feature of the File command when you're ready to create a new resume.    You'll go 
directly to the Layout Screen, where you'll see a blank new resume ready to use.

If the previous resume was edited but not saved, you will be warned and you will have the 
option to save the resume before the information is erased.



Open
Use this feature of the File command to open an existing resume.    When you do, a pop-up 
will prompt you to select a resume (the are normally stored with the .RME extension in your
Resume directory).    Simply click on the one that you want to use, then on OK, and you'll be
ready to View,    Edit, Format or Print your resume.

User's Tip:    So that the sample resumes don't get mixed up with your own, they are opened
via a slightly different procedure:    click to see help for Ideas now, for more information. 
Note: Sample Resumes are stored with a .RMS extension.



Save
Use this feature of the File command to save the current resume.    

If you've saved this resume before, it will be updated under the existing name.    If you 
haven't saved this resume, you'll be prompted to assign it a name before it is saved.



Save As
Use this feature of the File command to save the current resume under a different name.    
You can use this to make multiple copies of any resume, including a Sample Resume.

A pop-up will prompt you to type in the resume's name.    Unless you specify otherwise, the 
resume's standard file extension will be .RME and it will be saved in the Resume directory.



Contents
To choose from a list a major help topics, select this feature from the Help menu.    Then, 
when the list of topics appears, simply click on the one that you'd like to learn more about.

Alternately, you can perform a Help Search to look for topics by keyword, or review Help on 
Help to get tips about using the on-line Help system.



Search
Selecting Search from the Help Menu will bring up the help system in Search mode.



Help on Help
Click here to get information about how to use the Help system.



About
Click here to learn more about Pro One Resume and its creators.



Use this feature of the toolbars Ideas command to review a selection of sample resumes, 
covering a wide range of careers and backgrounds.    They are designed to provide 'real life' 
examples of how to use structure, text and formatting to produce the best possible resume.

User's Tip:    Although the job histories described in the resumes are drawn from actual 
experience, the applicants and addresses are fictional.    Any similarities to actual people, or 
hiring decisions on the part of mentioned companies, are unintentional.



Use this to review a selection of sample cover letters, covering a range of situations.    They 
are designed to provide 'real life' examples of how to use a cover letter to highlight your 
interest and qualifications, and help your resume to stand above the crowd.

When the pop-up appears, simply click on the name of any cover letter that you'd like to 
review.

User's Tip:    Although the situations described in the cover letters are drawn from actual 
experience, the applicant names, company names and addresses are fictional.    Any 
similarities to actual people or employers are unintentional.



Use this to review a selection of sample thank you and follow-up letters, covering a range of 
situations. 

When the pop-up appears, simply click on the name of any thank you letter that you'd like to
review.

User's Tip:    Although the situations described in the thank you letters are drawn from actual 
experience, the applicant names, company names and addresses are fictional.    Any 
similarities to actual people or employers are unintentional.



Use this to review a selection of worksheets which are designed to help you to organize a 
better resume and manage a more effective job search.

When the pop-up appears, click on the name of the worksheet that you'd like to view and/or 
print.



Use this to review idea-generating word lists.    They include:

Action words:    A dictionary of verbs designed to help you write a dynamic and 
effective resume.

Job Titles:    For your reference, as you think about next steps in your career.
SIC Codes:    Standard Industrial Classification codes, which can help you identify 

industries to target in your job search.



Layout Screen
The Layout Screen is Pro One Resume's main work area.    You'll use it to create the layout 
of your resume, to make changes, or to print.    Then when you're ready to preview your 
resume, click on the toolbar's View command to see and use the View Screen.

The Layout Screen must be displayed in order for you to add or delete sections to and from 
your resume.    Here's what it looks like: 
 

    

In addition to the standard toolbar, you'll see two important features:



The Resume Sections Box (to the left).
The Resume Layout Box (to the right).

Click on either of these features, now, for more information on using it.



View Screen
The View Screen is Pro One Resume's alternate work area.    Once you've used the Layout 
Screen to define your resume's basic structure, you'll probably want to use the View Screen
to view, edit or format your resume in preparation for printing.

The view screen shows how your resume will load when it is printed (see sample below).    
To return to the Layout Screen, simply click on the toolbar icon.    Alternately, you can click 
on any of the other icons to make changes, or to print your resume.

Click on any of the highlighted Help topics to learn more about using it.

User's Tip:    To edit from the View Screen, don't forget to select the Resume Section that you 
want to change BEFORE you click on Edit.    To select a section, simply click on it:    the 
highlight will confirm your selection.    



Resume Sections Box
The Resume Sections Box is a basic feature of the Layout Screen.    It provides all of the 
tools that you need to:

Select standard sections and add them to your resume.
Create new (custom) sections and add them to your resume.
Add or delete resume sections from the box.

Click on any highlighted topic to learn more about it.



Standard Resume Sections
Pro One Resume prompts you with a list of standard resume sections.    They represent the 
basic types of information that are displayed on most resumes, including Name/Address, 
Objective, Experience, Education, etc.

The sections include four basic format types.    Most Resume Sections will record their 
information in a normal (open-ended) type of format:    When you're typing in this kind of 
information, you'll be prompted with a single box.    In addition, specialty formats are 
provided for the Name/Address, Education and Experience sections, where you may want 
to do some fancy things when you're styling your resume. 



Custom Resume Sections

Use the Add button on the Resume Sections Box to create a custom resume section.    A pop-
up will guide you through the steps necessary to create the new section. 

You'll assign the section its name, and indicate whether or not it requires a special format 
(such as is used for Name/Address, Experience or Education).    Then click on OK to add the 
section. It will appear on the list in the Resume Sections Box, in proper alphabetical order, so
you can use it again and again.

Similarly, use the delete button to delete unnecessary Resume Sections. 

User's Tip: Custom and standard Resume Sections can be deleted.    Keep in mind that the 
deletes are permanent in both cases (although you can always use Add to create a section 
again).



Resume Layout Box
The Resume Box is a basic feature of the Layout Screen.    It enables you to create, edit and 
review the basic structure of your resume.

The first thing you'll want to do when you create a new resume is to set up its sections.    To 
do this, simply click on the section that you want to use (you'll find a list in the Resume 
Section box, to the left of the screen), then drag it to the resume.    Continue adding 
sections until your resume has been structured.

Then, to fill in the information for any section, simply click where it appears on the Resume 
Layout Box.    When an outline indicates that the proper section has been selected, click on 
Edit to start typing in your information.    Before you know it, all of your sections will be 
filled in, and your resume will be created!

User's Tip:    If you need to change the order of your sections, or see how your resume looks 
without a particular section, simply drag any section back to the Resume Section Box, and 
park it there.    Then select the section again, and drag it back to the new (correct) position 
on the resume.    All of the information which you're typed in to that section will be saved.



Style

Use this Format option to add sophistication to your resume by formatting your 
Name/Address, Experience and Education information in a variety of styles.    You can also 
use it to change the spacing of your headings.

Depending upon the type of information you are formatting, your style options may include 
separator lines, position of fields, size and face for fonts, and columns.    For more 
information, click now to see the help for Name/Address Styles, Experience    Styles, 
Education Styles and Heading Styles.    Or simply give it a try:    the sample box will show you 
the effect of your changes instantaneously.

User's Tip:    Style options apply only to specific types of text.    So if you've selected a 
mixture of Headings and Bodies, or have selected two or more different types of Resume 
Sections, the Style button will not appear.



Copy

Use this to copy the selected text.    Then use paste to place it in the new location.

To select text, proceed in the usual Windows fashion:    position your printer at one end of the
section, press down the left mouse button and drag the highlight until the entire section is 
selected.

User's Tip:    To move information, use the cut feature instead of copy and save yourself a 
step.    Or to add an entire Education or Experience Section, use the insert tool.    For more 
information about selecting text in Windows, consult your Windows User's Guide.



Cut

Use Cut to delete selected text from your resume.    Then you can leave it deleted, or use the
paste option to place the text in a new location.

To select text, proceed in the usual Windows fashion:    position your printer at one end of the
section, press down the left mouse button and drag the highlight until the entire section is 
selected.

User's Tip:    To move information with less chance of making a mistake and losing it, use the 
copy option.    Then delete the text manually, after it has been successfully moved.    Or to 
add an entire Education or Experience Section, use the insert tool. 



Paste

After you're used cut or copy to place a selected text in the windows clipboard, use paste to 
insert it back onto your resume.

User's Tip:    Since paste works off of the Windows clipboard, you can use the paste command
to add text from other Windows applications.    To do this, simply copy the text to the 
clipboard in another application, switch to Pro One Resume, place the cursor at the desired 
insertion point and paste the text.    Or to add an entire Education or Experience Section, use
the insert tool. 



Print
Use this print option to print a copy of the current resume and make changes to your 
printing specifications.    A pop-up will then prompt and guide you through your various 
printing selections, including:

Print setup for selection of printer and printer connection.
Range of pages to print.
Number of copies to print.
Print quality.
Printing to a file.
Collating copies.

Once all of your specifications are set, simply click on OK to print your resume.

User's Tip:    If you're having problems printing from Pro One Resume, begin by making sure 
that you're correctly set to print any other Windows Applications.    If not, consult your 
Windows documentation for assistance.



Print Setup
Use this make changes to your printer selection, printing orientation, paper characteristics, 
or other printing options.    Then click on OK to save your changes.



Set Margins

Use this option of the Print command to make changes to your resume's margins. Simply 
click on the up and down arrows until you reach the desired dimensions.    

User's Tip:    Check out your resume in View mode, to see the effect of your margins before 
you print.



Name/Address Style
After selecting a Name/Address section, use the Style option to add sophistication to your 
resume.    Select among its features, including:

Separator lines, to highlight your name and address and add spacing:

          

Columns, to change the layout of your name vs. address:

Font options for your name:

As you make your choices, keep an eye on the sample box (see example below) to see how 
they look.    When you've reached the perfect combination, click on OK to add this style to 
your resume.

User's Tip:    This style applies to any Resume Sections which have been created in 
Name/Address format, including Custom Resume Sections.



Experience Style
After selecting an Experience section use the Style option to add sophistication to your 
resume.    Select among its features, including:

Columns, to organize your information:

Separator lines, to highlight the various stages of your experience:

Fields, to specify the order of your information and to add special font faces:

As you make your choices, keep an eye on the sample box to see how they look.    When 
you've reached the perfect combination, click on OK to add this style to your resume.

User's Tip:    This style applies to any Resume Sections which have been created in 
Experience format, including Custom Resume Sections.



Education Style
After selecting an Education section use the Style option to add sophistication to your 
resume.    Select among its features, including:

Columns, to organize your information:

Separator lines, to highlight the various stages of your education:

Fields, to specify the order of your information and to add special font faces:

As you make your choices, keep an eye on the sample box to see how they look.    When 
you've reached the perfect combination, click on OK to add this style to your resume.

User's Tip:    This style applies to any Resume Sections which have been created in Education
format, including Custom Resume Sections.



Heading Style
Use the Heading Style feature to add sophistication to your resume, by changing how your 
headings appear relative to the bodies of their sections.    

        

Simply click on the options above to add spacing or a colon to your heading(s).    

User's Tip:    Don't forget that you can use the hidden text option for any headings that don't 
need to appear on your printed resume.



Font

Use this Format option to specify font characteristics for the selected heading or section.

Click to make your selections for the font, font size, font face (bold, italic or underline) and 
color.



Alignment

Use this Format option to specify the alignment for the selected heading or section.

Click to make your selection.

User's Tip:    Choose Justify to align your text on both the left and right margins.



Hidden Text

Use this Format option to specify whether or not a selected heading or body is printed on 
your resume.

Click on visible or invisible to make your selection.

User's Tip:    This option is most commonly used to make a heading invisible (see the sample 
resume for Actress, for example).



Indenting

      

Use this Format option to specify your tab settings.

Click on the up and down arrows to increase or decrease the width of the right and left tabs.



Bullets

Use this Format option to use bullets to highlight the selected heading or section. 

Click to choose the bullet style you like best, or to choose the no bullets option.

User's Tip:    When bullets are specified for a body of text, a bullet will appear on each new 
paragraph (i.e., after each end of line).



Insert

Use this Edit option to insert a new item to your Experience or Education section.    Simply 
click to select the item number that you want to insert before, then click on Insert.

User's Tip: To insert in other sections, simply position your mouse and start typing.    The 
Insert and Delete features can be used on all sections which were created using an 
Experience or Education format, including Custom Resume Sections.



Delete

Use this Edit option to delete a listing from your Experience or Education section.    Simply 
click to select the item number that you want to delete, then click on Delete to remove it.

User's Tip: To insert in other sections, simply position your mouse and start typing.    The 
Insert and Delete features can be used on all sections which were created using an 
Experience or Education format, including Custom Resume Sections.



Replace With
Use this to replace the highlighted word with the one that's suggested in the Replace Box.    
As soon as you do, the replacement will be made and the spell checker will continue 
reviewing the remainder of your resume.



Ignore
Choose this if you want to ignore any suggested replacements for the highlighted word.

User's Tip:    Don't hesitate to add words, especially proper nouns, to your Custom 
Dictionary.    Doing so can make spell checking more effective and less tedious.



Add to Custom Dictionary
Use this to add the highlighted word to your Custom Dictionary.    The suggested correction 
will be ignored, and the spell checker will continue reviewing the remainder of your resume.

User's Tip: Creating a good Custom Dictionary can make spell checking more effective and 
less tedious.    So don't hesitate to add words to your dictionary, especially proper nouns 
(such as your name, home town, college, etc.).



Clear Custom Dictionary
Use this to delete all of the words from your Custom Dictionary.    All words in the dictionary 
will be deleted, and you'll be free to start creating a Custom Dictionary again.

User's Tip: Creating a good Custom Dictionary can make spell checking more effective and 
less tedious.    So don't hesitate to add words to your dictionary, especially proper nouns 
(such as your name, home town, college, etc.).



Ok or Cancel
As always in Windows, click on Ok to save the current changes or Cancel to ignore them.



Export
Use this if you want to edit a thank you or cover letter.    A pop-up will prompt you to assign 
the letter a filename and directory, then will export it in text (.TXT) format.    Once that's 
done, you can use a word processor or Windows Write to open the letter and edit, reformat 
or print it just like any other text document.



Resume Sections
Resume Sections are the building blocks of your resume.    They store the information that 
will appear on your resume, such as Name/Address, Objective, Experience, Education, etc.

Pro One Resume provides a variety of standard resume sections, as well as giving you the 
opportunity to create Custom Resume Sections.    To start using Resume Sections to build 
your resume, you’ll use the tools that appear on the Layout Screen.    They include the 
Resume Sections box, the Resume Layout box and the Edit toolbar command.

To allow maximum flexibility when formatting your information, we’ve created four different
types of Resume Sections.    Most sections are what we call Normal sections; that is, they 
store all of their information in a simple, open ended format.    In addition, Name/Address, 
Education and Experience are specialty sections, which can take advantage of special Style
options when they’re being formatted for printing. 

Click on any of the highlighted Help topics to learn more about it, now. 




